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1. Included with the WinTV-HVR-1975

programs depends upon how fast your PC or laptop system is. Other
PC activities that consume CPU resources might affect the display of
ATSC digital TV. Slow video, jerky video and momentary pausing of
video are all results of a CPU which is temporarily being used by other
activities.
The portable antennas are designed primarily for ATSC digital TV
reception, and will work within 10 miles of an ATSC transmitter
(reception might be limited by obstructions such as steel buildings).
For the best ATSC digital TV reception, a roof top ‘High gain’ antenna is
recommended. In the U.S., a good ATSC digital antenna selector can be
found at TitanTV.com under Resources.

3. Installing the WinTV-HVR-1975

•

WinTV-HVR-1975 with ATSC/NTSC/clear QAM receivers for
North America and PAL, DVB-T, DVB-T2 and DVB-C receivers for
Europe and Asia. Plus FM radio receiver and MPEG-2 hardware
audio/video compressor for recording analog cable TV to disk

The WinTV-HVR-1975 is a USB device designed for Microsoft®
Windows 8.1, 8, 7, Windows Vista (all versions) and Windows XP SP2. It
can be used with the Hauppauge WinTV application, with Windows
Media Center and other TV tuner applications.

•

Remote control
transmitter and batteries

Connect the WinTV-HVR-1975 cables

•

IR Blaster cable

•

Wall mounted power
supply (6 volt)

•

1 meter USB cable

•

FM radio antenna

•

WinTV Installation CDROM

Plug one end (the square end) of the supplied USB cable into the
WinTV-HVR-1975’s USB Cable connector. The WinTV-HVR-1975 is
compatible with USB 2.0 (high speed USB) only.
Plug the other end of the USB cable into a USB port on your

•

WinTV-HVR-1975 Quick Installation Guide (this guide)

computer.

•

IR Remote Blaster Quick Installation Guide

The S-Video and Composite video inputs and the L&R audio inputs
can be used to bring audio/video from a VCR, DVD player or satellite TV
receiver.

ATSC digital TV is over-the-air digital TV for North America.
ATSC digital TV typically requires an antenna for reception, and is
currently broadcast in 200 cities, with over 1500 TV stations. Note:
ATSC digital TV is NOT digital cable TV or digital satellite TV. To watch
and record satellite TV, you need a satellite receiver box plus the WinTVHVR-1975.
ATSC digital TV is transmitted in several resolutions, from “standard
definition” which is similar to cable TV, up to high definition which has
about 16 times the resolution of normal cable TV. In any resolution,
ATSC digital TV gives sharper pictures than analog cable TV and near
CD quality sound.

Information on the installation of the IR Blaster Cable can be
found in the IR Remote Blaster Quick Installation Guide.

Plug the power supply into WinTV-HVR-1975.
Plug the supplied Power Supply into the Power Supply input on
WinTV-HVR-1975. The WinTV-HVR-1975 can accept 6V to 12V inputs.
S-Video
input

Composite
video input

Left &Right
Audio Inputs

Clear QAM TV channels are digital cable TV channels which
are broadcast on cable TV “in the clear”. These digital cable TV
channels are broadcast in various resolutions, from standard definition
up to high definition.
WinTV-HVR-1975 has a built-in tuner for analog cable TV, digital ATSC
and clear QAM digital cable TV. To receive ATSC, you will need an
antenna. To receive digital clear QAM or analog cable TV, you will need a
cable TV connection.

TV Connector
for antenna or
Cable TV

FM radio
antenna
connector

IR Blaster
output

USB Cable
Connector

Power Supply
input: 6V to 12V
@1.7A

5. Running WinTV for the first time
To run WinTV v7 for watching TV, recording videos and
playing them back on your PC, double click on the
WinTV icon on your Windows desk top.
When you run
WinTV for the first
time, the WinTV

Device Setup
Wizard appears.
Select the TV source
that you are using.

ote: If you’d
like to use
the A/V
inputs, please
see instructions
below in External audio/video sources.

N

If your TV source is ATSC digital over-the-air TV

Encrypted channels are automatically not selected and will not appear
in your channel list. The resulting channels in the list might be both
standard and high definition channels.

“Hauppauge WinTV Installation
CD-ROM” window will appear on the
screen.

ote: if the CD does not autorun, navigate to the CD and run the
'Setup.exe' file.

N

Install the WinTV driver
Click the button labeled Step 1: Install Drivers.

Once the drivers have installed, click on the Finish bar to exit.

Install the WinTV applications
Click the button
labeled Step 2:

Install WinTV
The setup
application will
then open and
begin
automatically
installing the
WinTV
application
components.
Once complete,
click OK then
Exit.
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Close WinTV
WinTV source selector

Current channel name
and number

Click the Scan
button and WinTV
will automatically
scan for analog
channels. The
scanning process
takes about 10
minutes.

Channel list display always on
Fast channel select
numbers
TV Channel list

Configuration
menu
(Settings menu)

Program Info

Record/Pause/Play controls

Playback file
menu

Volume adjust
and mute

Channel
up/down

Watch TV

External
audio/video
sources
You can bring video
into the WinTV from
an external audio/video source such as a cable TV or satellite set top
box.
In the Device

To see the TV Channel list, click your right mouse button in the TV
window to display the Options menu. Select Find Channel. You will
see the channel list.

To display the channel list all the time, while the channel list is
displayed, click the Channel list display always on button.

Options menu
The Options menu is the main menu where you can select channels,
turn on close captions, open the TV Scheduler and many other of the
most important TV control functions.

You will be
presented with the
option to add a
Composite and an
S-Video Input.
Please select your
country (if not
correct) and click Next.

To bring up
the Options
Menu, click
your right

Options menu
click your right mouse button to view

Playback menu
Channel list

mouse
button once

ote: Pal BGHIDK is the commonly used format in Europe. NTSC is
the broadcast format used in North America.

N

TV Scheduler

in the TV
window.

Close captions

To see the
channel list,
Always on top
click on Find
channel. You
will see the list of channels which have been scanned.

To show the Channel menu as part of the TV window, click the
Channel list always on icon at the top of the channel list.

Rescanning TV channels
If you want to rescan for TV channels, click the Configuration menu
(Gear button in the lower left corner of WinTV v7).
Then click on the Devices tab. Chose your WinTV device by clicking on
it, then click Tuner setup. Choose the TV format you want to scan, then
click Next. Click Next and a new scan will be started. When the scan is
complete, click Next / Next and OK.

IR blaster in WinTV v7
If you would like to use the Hauppauge IR blaster to change the
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Insert the WinTV Installation CDROM in your PC’s CD-ROM drive.

To watch TV, click the Watch TV button.

If you wish to connect a source not normally designed for operation in
your country, you can configure the Video Format manually from the
drop down list. Change the value from “AUTO”.

Clear QAM digital cable TV channels are those TV channels broadcast
on a digital cable network which are unencrypted (‘free to view’). If you
are using cable TV with clear QAM programs, chose Digital QAM and
click Next.

For all versions of Windows:

Using the WinTV v7 application

Select your
Country and your
TV Source from the
drop down list. To
automatically scan
for channels, click
Next to continue.

When complete,
click Next / Next / OK.

If your TV source is Clear QAM Digital Cable TV

Insert the WinTV Installation CDROM in your PC’s CD-ROM drive.
You will see an AutoPlay
message.

channels on your cable TV or satellite set top box, see the section
entitled “Configuring the remote control for WinTV v7”.

If your TV
source is
Analog cable TV

Setup Wizard,
select External
Inputs and click
Next.

N

For Windows 7 or 8:
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Select Digital ATSC and click Next. In the ATSC Setup menu, click
Next. You will see
the Digital ATSC
Scan scanning for
over-the-air
channels. The digital
TV scanning
process will scan
from channels 2 to
51. As TV channels
are found, they will
appear in the
Channel box.

ote: if you do not receive any ATSC digital TV channels, an
antenna signal booster might be needed. After adding a signal
booster, see below for instructions on rescanning and the
Troubleshooting section for information on choosing an antenna.

windows to load fully before
proceeding. You might see this
message two or three times.
Please click ‘Cancel’ each time
you see the New Hardware
Wizard.

N
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N

Please cancel it and allow

ote: Please do not lose your WinTV CD-ROM! You will need to
use it each time you upgrade to a new version of WinTV.

It uses your PC or laptop’s CPU for displaying both analog and digital TV
programs on your PC screen. The decoding of high definition ATSC is
very processor intensive, and the smoothness of high definition TV

ote: the latest driver updates are available at:
www.hauppauge.com in the Support section.

After you install your WinTV device and boot Windows, a 'Found New
Hardware' wizard will appear.

A screen will open and begin installing the drivers for your WinTV.

Boot your PC.

Remote control
receiver

For Windows XP installations:

Click Run Setup.exe

Plug your TV antenna or cable TV cable into the WinTV-HVR-1975’s
TV Connector. Plug the supplied Radio aerial into the FM radio
connector. Note: this may not be necessary if your TV aerial or cable
network supplies FM.

2. What is ATSC and QAM digital TV, and how
does the WinTV-HVR-1975 work?

4. Installing the WinTV driver and application
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To turn on Close captions, click on Show Captions.
To manually schedule a TV recording, or to see which programs
have been scheduled, click on Scheduler.
To turn on the Always on Top mode, click on Stay on Top.

Watch, Pause and Record TV
WinTV v7 is always recording video to your PC’s hard drive while TV is
being displayed. In this way, you can immediately skip back and replay
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Time bar
Program
info
button

Playback
file
button

Record
button

Stop button Skip back 1
minute
button

Skip ahead 1
minute button
Pause/Play
button

time” you can change the WinTV v7
application to FM by clicking FM radio in
the Source selector, found in the upper
right hand corner of the WinTV application.

Day of the
Week for the
recording.
-

Date to Begin
Program:
today's date is
the default.
Change this if
you want to
schedule on
another date.

-

Source
selection:
leave set at
WinTV to bring
up the WinTV at
the requested time and on the requested channel.

Configuration menu
The WinTV v7 Configuration menu is accessed by clicking the gear
button in the lower left hand corner of WinTV v7.

the TV program you are watching.

General tab: you can set the Video Renderer which allows
WinTV v7 to display video with a wide range of graphics systems.

Clicking on the Pause button will cause the video to pause, while
clicking the Record button will cause the current TV program to be
recorded to hard disk.

Devices tab: allows is where you can re-scan for TV channels
and set up the TV sources in WinTV v7.

Recording your TV shows

Parental control tab: is where you can set the Parental Control
level.

If you want to record a TV show you are watching:

-

Click the Record button. The recorded file name will popup on
the video for a few seconds as the recording starts.

-

When you are finished recording, click the Stop button.

-

Click the Playback file button and select the last file recorded
to play the video you just recorded

-

To play a video you recorded earlier, click the Playback File
button and then move your mouse and click once on the video
you want to play. Click Open and the file will start playing.

Once these are set, click OK. You can add more recordings, clicking OK
after each event is
set.
When you are
finished click Close.
The WinTV program
does not have to be
running for the
Schedular to work. If
WinTV is not
running, it takes
about 15 seconds to
start WinTV and to
start the recording of
TV.

The recorded video file is saved in the directory set in Recordings
directory which can be found in the Configuration menu. The
default directory is MyVideos. To change the default directory, click the
Settings button and then the Folders tab. Every time you record a file,
a new file is automatically created. The file will be formatted as
(ChannelNumber)_(ChannelName)YearMonthDay_TIme.
For digital TV programs, the quality level recorded is the same as it is
transmitted by the TV station. For example, if the TV station is
transmitting a high-definition program, WinTV will record the program in
high-definition.

Advanced options: you can set options such as Convert TV
recordings to .MPG file type and Game mode here.

Close captions, parental control information and SAP audio are
recorded with digital TV programs.

TV Scheduler

For analog cable TV using the built-in hardware MPEG-2 encoder, the
quality of the video recording is set to 6Mbits/sec. This will be a
configurable setting in a future version of WinTV v7.

WinTV v7’s built-in TV Scheduler allows you to schedule the recording
of TV shows. Once a record event is set, WinTV v7 can be closed and
will “wake up” at the desired time and tuned to the desired channel.

If you want to pause a TV show you are watching:

When a scheduled record event takes place, the WinTV v7 application
records “in background” so that you can continue to watch your live TV
program, even as the recording progresses.

-

Click the Pause button. Your TV video will stop and the Time
counter will start counting.

-

To start the video from where you paused, click the Play button

-

To rewind the video to the beginning, click the Skip to the
beginning button. If your video was paused, click the Play
button.

-

To rewind the video 1 minute, click the Skip back 1 minute
button. If your video was paused, click the Play button.

The Delay counter displays how much time you are behind the live
video. For example, if the delay counter says 00:01:23, then the video
window is showing video 1 minute and 23 seconds behind live video.

Selecting FM radio programs
On those WinTV products which support FM radio, if you have scanned
for FM radio staions in the section entitled “Using WinTV for the first

Pause button: if watching live TV, will pause the video. When recording,
this button will pause the video but WinTV will continue to record. If
playing back video, this button will pause the video playback.
Stop button (square icon): stops live TV, the recording or playback.
Play button: plays the last video recorded.
Back/Exit button: will close the current menu or exit full screen mode.
0 - 9 buttons: When in “live” TV mode, is used to directly enter channel
numbers. When
playing back a
recording, the
Application
“1” button will
on/off
Go
button
skip to 10%, the
“2” button 20%,
TV
button
etc. of the length
Back/Exit
button
of the recording.

Skip back
button: skip
back 30
seconds.
Go button: Start
WinTV.
Menu button:
opens channel
list.
Power button:
close WinTV or
Windows Media
Center.

Menu
Channel
up/down

Audio
mute
Record
button

Stop
button
0 - 9 “Quick
Skip” buttons

Skip
ahead

Skip
back
Pause
button

Fast
forward
Play
button

If you need to restart the remote control, select Restart IR from the Start
\ All Program Files\WinTV directory.

The items that need to be set for each event are:

1. Infrared Remote control - has batteries inserted

-

Name: you can add a name to the recording. If you do not enter
a name, the name will be in the channel/date format.

2. Infrared-Receiver, is fully connected to the IR socket of the
WinTV-Card

-

Channel: chose one of your scanned channels.

-

Start time: set to the desired start time. Click on the hour to set
the hour, the minute to set the minute. Note: It takes about 15
seconds to launch the WinTV and start recording.

-

Duration: number of minutes in the recorded program.

-

Recurrance: one time, daily, weekly.
Note: If you set for Record Weekly, you must also specify the

Troubleshooting
ote: the latest WinTV-HVR-1975 software can be found at
www.hauppauge.com/site/support/support_hvr1975.html

N

Some notes on system compatibility
Decoding high definition ATSC TV is very CPU intensive. A graphics
card with at least 64MBytes of memory and the latest graphics driver
from the manufacturer makes the decoding task easier. Typically a 2.2
GHz Pentium 4 processor or equivalent with a graphics card having
64MBytes of memory is required to properly decode ATSC digital TV on
your PC. A 1.6GHz AMD Sempro laptop computer tested in the
Hauppauge lab used 50% of the CPU for playing ATSC 640i format, and
90% of the CPU when playing ATSC 1080i, the highest definition ATSC
format.

Sub-titles on / off

Please ensure the following before trying to use this option:

3. Infrared software is started - The IR icon is on the start bar
To start WinTV, press the GO button.

Remote control buttons
TV button: when WinTV is running, this button will start live TV (if in
playback mode).
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If this setting does not help, or if you experience WinTV not responding
after a channel change, then your graphics system cannot use hardware
graphics acceleration. In this case go back to settings and uncheck
“use hardware acceleration” and rerun WinTV.

Only some channels are found during ATSC channel
scan
If you are only receiving some known TV channels when scanning, it
means your TV antenna is not adequate to pick up the channel. You will
need either an antenna signal booster (a Radio Shack antenna amplifier
will work) or a high gain antenna. Here’s a link to an ATSC antenna
selector:
http://www.antennaweb.org/aw/address.aspx

Black window when selecting an ATSC channel

In some cases, either a faster processor or more graphics memory
might be required. Slow or jerky video and a noisy TV picture indicate
system performance problems.

A black window when selecting an ATSC channel means that the WinTVHVR-1975 is not getting a signal. This is most often due to poor
reception. See “Only some channels are found during ATSC channel
scan” above.

Jerky video with live ATSC or QAM digital TV

Uninstalling the WinTV driver and applications

Jerky or distorted video can be caused by two things in your PC or
laptop: a slow CPU which cannot decode the ATSC TV signal fast
enough, and a graphics system which cannot keep up with the high
datarates of digital TV.

Run the hcwclear.exe from the installation CD. Select OK A black
screen will briefly appear and once it has disappeared the software will
be removed. If you now re-start the computer you will be at Step 4 of the
installation.

Many times, improving the performance of the graphics display will fix
the jerky video display of ATSC digital TV. Here are some tips on
improving graphics performance:
- Use the latest graphics driver: graphics drivers are often ‘tweaked’ to
improve performance, especially the built-in graphics on laptops. Check
the Microsoft Windows update site to download the latest graphics
driver for your computer. For Dell computers, check the Dell website for
the latest graphics driver.
- Use WinTV v7 Video Renderer settings to optimize graphics
performance: The Video Renderer is found in the General tab of
WinTV v7, and is used to change the display mode of a graphics card
for TV watching.
This setting does
not affect any
other Windows
program.

Sub/CC (#):

You will see the WinTV Remote icon in the Device Tray. The installation
will add a shortcut to IR.EXE to the Startup group, so that IR.EXE is
loaded every time after Windows has booted.
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Red record button: starts recording using the parameters set in the
Pref menu.

Volume
up/down

The WinTV remote control software is installed automatically during the
installation of the WinTV applications.

The TV Scheduler can be found in the WinTV v7 Options menu.
Right click your mouse button in the TV window to see the Options
menu. Click Scheduler. To set up an event for timed watching or
recording, click the Add button.
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Skip ahead
button: skip
ahead 30
seconds.

The Hauppauge remote control

The default mode
is EVR. The other
modes are
VMR9, VMR7
and Overlay.
Each mode uses
a different
process to render
video. Try each
mode and use the
one which gives
you the best
results.

Keyboard shortcuts
Ctrl A

Aspect ratio

Alt P

Previous channel

Ctrl D

Display the video and audio
format of the TV program

Ctrl Q

Pause

Ctrl P

Play

Ctrl F

Freeze the video

Alt R

Record

Ctrl Z

Open TV Scheduler

Alt S

Stop

Ctrl O

View program details (digital
TV program, where provided
in the broadcast)

Alt T

Start TV

Ctrl C

Catch up

Ctrl S

Display subtitles

Ctrl >

Skip ahead

Ctrl W

Full screen toggle

Ctrl <

Skip back

Alt F

Open File menu for playback

Alt M

Open the Task Menu

FCC Statement
Radio Interference Statement:

To use hardware graphics acceleration, put a check in the tick box Use
hardware acceleration when possible. This will allow your graphics
system to use hardware acceleration for video decode. Note: graphics
hardware acceleration does not work on all systems.

The WinTV products have been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses,
and can radiate radio frequency energy and cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures: reorient or relocate the receiving antenna,increase the separation between the equipment and receiver, connect the equipment into an
outlet on a circuit different from that to which the receiver is connected, consult the dealer or an
experienced radio/TV technician for help.CAUTION: Changes or modifications not expressly
approved by the party responsible for compliance to the FCC Rules could void the user's authority
to operate the equipment.
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